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Executive Summary

Note to users of the ACP Template:  The following template has been prepared to assist personnel at the installation or their contractors.  The use of this format is not mandatory and can and should be altered to suit the needs of the individual installation.  This is simply an example of a common way to present the relevant information.  Refer to the Process section under Develop Plan for more instruction on the use of this template.
Purpose

Achieving facilities excellence requires careful planning and articulation of standards.  The purpose of the Architectural Compatibility Plan is to establish and document installation-specific standards and provide a tool to assure these standards are consistently applied.  The Architectural Compatibility Plan strives to recognize the cultural, environmental, climatic and existing facility conditions peculiar to X AFB and define the appropriate styles, finishes, and materials to be used to achieve the best facility life-cycle costs and still retain the appropriate environment for people to achieve their highest productivity and efficiency.

The Architectural Compatibility Plan is an element of the Capital Improvements Plan.   The Capital Improvements Plan is a component plan to the Installation General Plan.

Audience

The primary audience for the Architectural Compatibility Plan includes the individuals involved in all phases of the facility delivery process.  This includes installation leadership, programmers, planners, designers, project managers, design agents, A/E consultants and constructors.  

Use

The Architectural Compatibility Plan is a tool to chart a course towards installation excellence and provides a means to assess the installation’s progress in achieving that end.  The Architectural Compatibility Plan is intended to be used at all stages of the facility delivery process from programming through construction, and even operations and maintenance.  It is essential that the Architectural Compatibility Plan be provided to the design agent and AE consultants early in the design process to assure that the entire design team understands the applicable design standards and objectives for the project.

.

Implementation

In order to ensure the Architectural Compatibility Plan is followed as projects are conceived, designed, and constructed, a single person at the installation is designated as the Architectural Compatibility Coordinator.  This person reviews all projects which alter the appearance of the site for conformance with the Architectural Compatibility Plan.  The coordinator annually updates the Architectural Compatibility Plan to ensure that it reflects the most current design objectives and standards for X AFB.  The Architectural Compatibility Plan has also been written to simplify the understanding of facilities design concepts as well as to provide specific information to use when carrying out routine facility maintenance or renovation.  

Organization

The Architectural Compatibility Plan has been organized to promote ease of use and to be easily updated and expanded.  The following sections describe the primary  areas addressed and how they are organized.

Chapter 3; Existing Conditions describes the character, assets, and liabilities on the installation.

Future Developments lists the installation design objectives and standards with regard to theme, scale
, form, articulation, materials, color, fenestration, and details.

Chapter 4; Visual District Standards graphically depicts the installation and its existing and future visual district(s).

Example Summary Design Guidelines:

X Air Force Base




M - Mandatory

P - Preferred

O - Optional
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Primer

Like the Chapter Title Style above, and the Chapter Subtitle you’re reading, Word’s preset Styles are just a few clicks away.
t
o save time in the future, print a copy of this document. Choose Print from the File menu, and press Enter to receive all 8 pages of examples and instructions. With the printed document in hand, position yourself in Normal View to see the Style names next to each paragraph. Scroll through 

What is Architectural Compatibility?

To understand architectural compatibility and how it affects the Air Force, an understanding of the term is necessary.  Compatible is generally defined as “capable of existing together in harmony, or to be consistent.”  Architectural compatibility results from designing and building facilities in harmony with their natural and man-made surroundings and environment.  Architectural compatibility would therefore be concerned not only with the physical appearance of buildings, but interfacing with planning, landscape development and interior design goals and objectives.

Architectural compatibility considerations are those planning and design factors which influence and enhance an installation’s physical appearance.  The decision as to what should be considered is determined by the situation and particular requirements of the installation, and the overall environment within which the installation exists.

Military installations should provide efficient and pleasant physical environments conducive to attracting and retaining skilled and motivated personnel.  The design, location, and maintenance of individual elements such as buildings, roads, parking lots, signs, and landscaping create the quality of the environment.  Each of the elements should be functional, attractive, and harmonious with each other.  This helps to create an environment that enhances the capability of the installations to support their mission(s), and fosters pride in, and a commitment to, military service.

Developing an architectural compatibility program can be an invaluable tool in achieving the following:

· Provide a record of established goals, objectives, and decisions leading to more consistent decisions when a change in installation leadership occurs.

· Improve the environment through the installation’s construction projects.

· Provide a mechanism for environmental design continuity.

· Develop a baseline for review and, of necessary, for changes that may occur as a result of redirection in goals and objectives.

· Establish consistency in installation development which takes into account all elements of the environment.

· Control design expression.  These controls should not be so specific that design freedom is restricted.  A designer should have sufficient latitude for creativity.

· Provide clear and consistent communication between the Air Force as a client and designers whether they are in-house or contracted professionals.

· Improve programming and budgeting by limiting the range of options and promoting consistency.  

· Impart a sense of pride, organization, vitality, and good management.  The installation should convey the feeling that it is a good place to work and live.  It should reflect a leadership that cares about its people.

The following sections define and discuss each of the three levels of considerations for developing architectural compatibility guidelines: visual elements, visual patterns and visual districts. The visual elements working together will form larger scale visual patterns, which in turn establish the theme for a visual district. 

Visual Elements

The following visual elements establish the physical appearance and character of an individual building or group of buildings. They include: Theme, Scale, Form, and Articulation.

Theme

Theme is a combination of materials, texture, colors, form, type of construction, details, and building systems.  Repetition of design elements in similar ways on separate buildings helps establish an architectural theme.  A theme may be based on historical, cultural, technological, and other standards.  Examples include Spanish, Western, modern, colonial and high-tech. 

· A theme should not be arbitrarily chosen.  A Spanish theme would not be appropriate in the Northeast.  

· Themes may reflect energy consciousness through passive and active solar design; they may reflect a historical period such as exists in many old brick buildings; they may simply reflect an appreciation and respect for the natural beauty and resources native to a region.  

· Themes should reflect the installation’s mission, heritage and regional characteristics, and emphasize human scale.

· Regional and local resources should be studied in evaluating existing themes.  Materials that are native to the region should be used.  Colors and textures should also be reflective of the region.  Details and type of construction should be characteristics of the area.

The theme must be considered when adding to, altering, maintaining and repairing facilities.

Scale

Scale is a comparison of the dimensions of various components of a building to other related elements and to human dimensions.  Scale also refers to the size relationships between adjacent buildings, and between buildings and adjacent open spaces.

· Proposed buildings should be scaled to be compatible with overall mass and individual parts of buildings in the visual district.

· New construction on the installation should avoid designs using one rectangular mass.

· Avoid vast blank building walls facing streets.

· Except for major buildings, the scale for all buildings should be human, not monumental.  This human scale is achieved by using small (normal sized) windows, doors and details.  It is also conveyed by using normal floor-to-floor heights and floor-to-eave heights.  

· For large buildings, human scale is improved to the extent that the mass is broken into smaller elements. 

Form

Mass and shape define form.  Mass refers to the volume defined by a structure relative to its surroundings and to its apparent solidity and weight.  Shape is the complexity of the surface planes.

· Use a roof form and shape similar to adjacent buildings.  

· Stress horizontal proportions in the design of the facade.  Design windows, entrances and detailing to complement the horizontal proportions of the facade.

· Emphasize the parts of all buildings to clearly show a division of roof, walls and base.  Utilize color, materials and/or details to express this division.

· Currently fashionable or “trendy” forms should be avoided.

· Major administrative buildings may have a more formal massing than any other building type, signifying their relative importance.  This can be achieved through a more balanced, symmetrical design with less articulation.

· Building entrances allow access into a building.  The scale and detailing of an entrance gives the pedestrian a visual clue to identify the function and importance of a building.  Building entrances should be readily distinguished as the “entrance” to all buildings.

· Locate primary building entrances to relate to adjacent building entrances and major pedestrian circulation routes.

· Locate main entrances away from service areas.

· Entrances should be an integral part of building design by means of:

Building recess

Building projection

Ornamental or decorative detailing

Glazed areas

· Location of building entrances should be a careful balance between the desired site arrangement and the internal layout of the building.

Articulation

Articulation is the discreet visual definition of architectural systems from bottom to top.  This promotes a discriminating use of materials, colors, fenestration and details.

Materials

Cohesive and consistent architectural character can be achieved in new construction through the use of exterior building materials that are similar to or compatible with adjacent buildings.

· A cluttered, cosmetic application of a number of different materials on a facade should be avoided. 

· Materials should be used consistently on all facades of a building.

· Materials should be selected based upon their appropriateness to the building type, durability, climatic conditions and the prevailing architectural design and character of the installation. 

· Materials distinctive to an established architectural character worthy of merit should be adhered to consistently throughout an installation. Deviations from established materials should not be allowed without good reason. However, an historic style should not be imitated where it is inconsistent with functional requirements and construction economies. The use of similar materials, complementary colors and a compatibly scaled building can successfully relate new buildings to an historical style or setting.

· For freestanding walls, use materials and colors similar to those on the main building.

Color

Color is closely linked to the appropriate selection of exterior building materials and is a critical design element in relating adjacent buildings and creating a compatible visual environment within an installation.

· In general, colors should be integral rather than applied to exterior building materials. Avoid surfaces that require costly periodic repainting.

· Colors should be selected on the basis of the desired appearance and attractiveness of the building, its compatibility with adjacent building colors and the prevailing color scheme of the architectural and natural landscape character of the installation.

· Colors should be carefully selected for their ability to modify climatic conditions. Generally, light-colored building exteriors tend to reflect solar radiation and promote heat loss, but increase glare; dark-colored exteriors tend to absorb solar radiation, promote heat gain and reduce glare.

· Exterior building colors should be limited in number and controlled by an established color palette for use throughout the installation. This palette should specify a limited number of coordinated and complementary colors that are subdued and harmonious.

· Strong, loud colors should generally be avoided and used only for special identification purposes; where they are employed they should not dominate or overpower the visual character of the setting.

· Colors can be used to evoke an historical or regional architectural style that should be employed only where appropriate. 

· Exterior appurtenances should match the color they are set against, i.e. roof penetrations shall match the roof color, and items attached to or adjacent to walls should match the wall color.

· Posts, gas meters, and exposed piping should be of a uniform tone-down color.

· Downspouts should be visually integrated into the facility architecture.  They should be specified to match or blend with the color of the adjacent wall material.

· Avoid the use of “supergraphics” painted on building facades.  

Fenestration

The fenestration of a building is the openings within the building envelope.

· Design openings to form a unified composition in proportion to the building elevation.

· Proportion and detail a building’s exterior fenestration to the scale of adjacent buildings.

· Window placement should relate to internal areas.  Mullion shaping should provide a good module for internal layout of office space, entrances, common use areas, etc.

· Larger building facades with oversized fenestration elements tend to create a more monumental scale while smaller buildings with more finely detailed fenestration tend to create a more human scale.

Details

Cohesive and consistent architectural character can be achieved in new construction through the use of details that are similar to or compatible with adjacent buildings.  Visual clutter can be avoided by thoughtfully detailing or eliminating exterior appurtenances.

· Locate above-grade utility connections, vents and other projections through the building away from high-visibility areas.  Do not locate any utility projections, such as air conditioning units, on the street side of the building.

· Avoid exterior surface-mounted conduits, electrical boxes, etc. 

· Roofs should be designed with the least number of penetrations possible.  In this interest, rooftop mechanical systems should be avoided whenever possible.  If rooftop units are unavoidable, mechanical roof “courtyards” should be considered to minimize visual impact.

Additional Design Considerations

Additional design considerations should encompass the following:

· Renovation/Rehabilitation

· Maintenance/Operations

· Temporary Buildings

Renovation/Rehabilitation

Renovations provide the opportunity to change materials which are no longer serviceable and add form enriching elements which would result in a building more consistent with the character of the installation.

· Use exterior materials and details that are compatible with those of adjacent buildings.  Architectural character, form and style must be especially compatible.

· In the construction of additions to existing buildings, use materials and details that are similar in color, texture and order to those on the existing building.

· Avoid the infill of windows and doorways except where dictated by security concerns.

Maintenance/Operations

Maintenance requirements need to be considered during the planning and design process for all buildings

· Design buildings to minimize life cycle cost, energy consumption and maintenance through the selection of proper materials and construction standards.

· Ensure that the facility orientation and wall sections do not encourage excessive passive heat gain.

· Wall assemblies shall be designed to minimize vapor infiltration and condensation.  To this end, vapor barriers are required for the local climatic conditions.  

· Use materials with integral colors to minimize repainting.

Temporary Buildings

These buildings are classified as temporary in the real property inventory, since they will be demolished as permanent replacements are constructed.  These buildings require maintenance and renovation to provide protection from weathering and deterioration until demolition.  In most cases, these buildings are utilized well beyond their design life.  The following guidelines should govern removal of these structures:

· Demolish and remove temporary buildings as soon as permanent replacements are constructed.

· Undertake maintenance and renovation work which is consistent in scope and cost with the anticipated time period until demolition.

0-5 Years:  Continue scheduled maintenance as needed.  This includes painting and minor repairs to roofs, doors and windows.

5-15 Years:  Schedule recladding, new windows and doors as needed.  Use compatible materials and colors.  Design building modifications to be consistent with the character of the building.  Do not construct any building additions.

15-25 Years:  Treat temporary buildings with this life span as permanent buildings.  For rehabilitation work, follow the guidelines for new construction and use appropriate material, details and color.

Visual Patterns

elements make up patterns
For example, a particular type of fenestration on the exterior of a building is an element that if clearly defined and incorporated on a series of related buildings forms a pattern that is recognizable.  If the pattern is an appropriate one and is well adapted across different buildings, it will be recognized as pleasing and contribute to the theme of the community as a whole.

patterns define districts

As patterns emerge they start to defined districts which have distinct and individual characters.  Identifying the districts and understanding the patterns that constitute it is key to enhancing the installation as a whole. 
The object is to establish desirable patterns that act as guiding principles for future design. The patterns are what breathes the spirit into the district, building or space.  Patterns exist on three levels;  urban scale, the building, and built details.  Architectural Compatibility is mostly concerned with the patterns that the practice of architecture can influence; buildings and their details.  

The following are a preliminary set of patterns that are relevant to Air Force Installations and are aimed at enhancing the experience of living and working on one.  This is by no means an exhaustive list, it is intended to be a point of departure for design development.  For a more information on the method of studying patterns as a means to achieve design excellence, refer to “A Pattern Language” by Christopher Alexander.

Visual Districts

Identify visual districts within the installation.  These districts are simply areas that currently have, or should have, a common visual theme.  Visual districts can be any size and any configuration.  Very often, visual districts correlate directly with land use areas, such as Industrial, Community or Administrative.  Other factors can often define visual districts, such as geographic features, circulation patterns, proximity to other functions, site lines, landmark buildings, etc.

Visual Character of Installation

Establish architectural guidelines that specify a general design vocabulary for all buildings within the installation.  The formulation of these guidelines should be derived from the following considerations as they relate to establishing a coherent theme, scale, form, and articulation among buildings within the installation.  These over-reaching installation standards, while providing variation within each visual district, establish a common “visual thread” that ties all of the districts together.

Landscape/Landform Character

The natural site character of the installation in terms of its terrain and vegetation may lend itself to a particular character of development and architecture.

Urban/Rural Context

The general character of development within the installation, in terms of its intensity of land use, indicates a type and scale of development pattern and architecture that can range from dense and urban to sparse and rural. The guidelines should specify a desired character or transition in character among facilities within the installation.

Climate

The climate of an installation should heavily dictate an appropriate character of development and architecture that is conducive to user comfort and energy conservation.

Prevailing Regional Architecture of Installation

A regional architectural character that has historically developed in response to the climate, natural setting and available building materials of the region can provide a useful model for establishing the overall architectural guidelines for the installation.

Prevailing Architectural Character of the Installation

The installation’s prevailing architectural character may serve as the practical basis for establishing the guidelines for a coherent architectural character within the installation.

Design Applications

· Establish a coherent overall architectural character within the installation that can apply both to new building design and the renovation of existing buildings.

· Design new buildings to promote a coherent architectural character by means of a compatible contemporary architectural design expression.

· Avoid trite cosmetic application of stylistic elements that allude to the architectural style of older installation buildings.

· Encourage variety that is compatible with the overall character of the installation; avoid promoting a rigidly homogeneous and monotonous architectural character.

· Avoid prefabricated or modular prototype building systems whose designs are out of context with the natural setting or architectural character of the installation; utilize only those building systems that can be adapted compatibly to the site and architectural character of the installation. Where procurement schedules or economics dictate the use of these building systems, select those of compatible design, scale, color and materials. Consider the use of plant material and screening walls to lessen any negative visual impact of these building systems.

Interfaces

Achieving design excellence on Air Force installations means understanding the impact that architecture has on the overall visual quality of the installation and the interaction it has with several other design disciplines.

Environment
In the process of implementing architectural compatibility initiatives, there is the opportunity to integrate environmentally responsible practices into the planning, design and construction process.  True architectural compatibility embraces sustainable practices as integral to the facility delivery process, ensuring the “best fit” of the built environment to the natural environment.

Planning

Planning on the urban scale provides the underlying structure for installation development.  The architecture should individually and as a whole reinforce the unifying elements of the General Plan.  Design excellence begins here; good architectural features can be lost if the master plan lacks a cohesive vision. 

Site Development

Site development integrates outdoor elements with buildings to create a unified design.  The architecture contributes to the site by establishing way-finding cues, defining outdoor spaces and communicating a language that places the building in its context on the installation.  In addition to the architecture, however, there is the art of designing natural spaces and fostering cohabitation with the natural environment. 

Interior Design

Just as the exterior architecture is articulated, interior spaces involve design on a smaller, more personal scale using space, material, light, color, texture, and pattern. As the exterior architecture fits into the master plan for the installation, so must the buildings interior and exterior functions complement each other.  This mandates understanding the experience of the architecture as a progression from outside to inside.

Obstacles

As you begin the process of developing an Architectural Compatibility Plan for your installation, it’s important to acknowledge and understand obstacles that may need to be dealt with along the way.

Lack of Awareness

It is sometimes easy for design professionals to forget that everyone does not see the opportunities and potential for visual improvements on an installation.  Simply making people aware of these issues can be vital to gaining support for your efforts.

Prevailing Attitudes

Often the attitude of “if it isn’t broke, don’t fix it” can be an obstacle.  Base leadership, that is often forced to focus primarily on day-to-day operations, can benefit greatly from exposure to a long-range vision for the visual quality and character of the installation.

Existing Conditions

A prevalent issue on most installations is the sheer quantity of facilities that may not conform to architectural compatibility goals.  It is important to be realistic about what initiatives can be implemented, how can the plan be phased and how can we turn selected existing conditions into visual assets to build on.

Funding Limitations

No obstacle is more prevalent than funding limitations in this age of military downsizing.  Realizing this, it is essential that an Architectural Compatibility Plan recognize and exploit the areas where the greatest impact can be realized for the least amount of money.

Opportunities

Opportunities for implementing architectural compatibility initiatives may present themselves in many forms.  A change of leadership, new construction projects already programmed, scheduled operations & maintenance projects, and partnerships with the community are just a few examples.  Funding and organizational avenues are described below.
Project Funding

While most Civil Engineering staffs have an individual whose primary function is to program the funding for installation projects, you must have a basic understanding of how the process works.  You must become familiar with the many and varied sources that are available to fund construction, maintenance, and repair projects.  You should be especially aware of funding issues that could affect facility requirements or could cause land use changes.  The following paragraphs briefly describe the primary sources of funding with which you should be familiar:

Military Construction Program (MILCON)

Consists of the authorization and appropriation of funds to construct and, in some cases, repair military facilities (Mission, Personnel Support, and Mission Sustaining Recreational Activities) that exceed local approval authority.  MILCON requires Congressional authorization and appropriation.  Projects should be identified at the installation level, and, through the comprehensive planning process, be reviewed, approved, and prioritized by the installation Facilities Board.  These projects are then successively reviewed and ranked by the Major Command (MAJCOM), HQ USAF, Department of Defense, and ultimately at the Congressional committee level.

Family Housing Investment Program

Includes construction and improvement programs and is funded by the Family Housing Investment appropriation.


1.  The Construction Program is used to construct or replace family housing units and support facilities, such as the Housing Management Office, Housing Maintenance Facilities, and Furnishing Management Warehouse.  Like the MILCON program, new/replacement construction projects require project-specific Congressional authorization and appropriation.


2.  The Improvement Program is used to do extensive construction work in existing units and associated maintenance and repair required to extend the life of the units by 25 years.  It also includes upgrades to other housing facilities, utilities, and pavements, and construction of non-dwelling units costing less than $10,000.  For Improvement projects, authorization authority ranges from MAJCOM to Congress, depending on the type of unit involved, and whether or not statutory limits on unit size and cost of work per unit are exceeded.  In most cases, the exception being Minor Improvement Projects (MIP), funding must be appropriated through the Congressional Budget Cycle. MIP funds are also annually appropriated, but are reserved for MAJCOMs to be used at their discretion on projects meeting MIP criteria.

Operations and Maintenance (O&M) Program

The O&M Program is a means by which work may be accomplished in most facilities on the installation.  This program may fund construction-type work costing less than $300,000, as well as maintenance and repair projects.  Exceptions are Family Housing, which has a separate O&M account, and some work in Nonappropriated Fund activities.   O&M, as MILCON, will have a significant impact on current and short-range aspects of your planning work.  O&M Program funds are appropriated to the services, and eventually to the installations, in lump-sum amounts.  Most O&M projects may be authorized by the MAJCOM.  This authority may be further delegated to the installation.

P-341 Funding:

Occasionally, construction requirements exceed O&M authority but can’t wait for the MILCON program.  Such requirements, costing less than $1,500,000, may be accomplished through a special program called P-341 Minor Construction.  Annually, Congress appropriates a small amount of funding for this program.  However, because this funding is extremely limited, installations must be able to justify the urgency of the projects.  The Deputy Assistant Secretary of the Air Force (Installations), SAF/MII, authorizes P-341 projects and notifies Congress within 30 days.

Family Housing Maintenance and Repair

Part of the Family Housing operating fund appropriation is used to accomplish major and minor maintenance and repair, as well as some associated construction work (termed Minor Alterations).  Like the regular O&M Program, these funds are appropriated to the services, and eventually to the installations in lump-sum amounts.  Authorization for these types of projects is normally provided by the MAJCOM; however, it may be delegated to the installation. 

Environmental Restoration and Cleanup Projects

These projects are funded by other subcategories of the O&M program through the Defense Environmental Restoration Account (DERA).  DERA funds are dedicated to environmental projects within the Department of Defense O&M budget.  These projects require Major Command and HQ USAF approval, and are typically initiated by the installation Environmental Office.

Nonappropriated Funds (NAF)

NAF funds, those not appropriated annually by Congress, originate from revenue generating sources such as golf courses and bowling alleys.  These funds support new construction, and in some cases, maintenance and repair, on revenue generating activities and are managed by three different NAF instrumentalities.


1.  Services:  These activities include Morale, Welfare, and Recreation (MWR), Lodging, and Food Service facilities.  Small NAF Service projects may be funded and approved locally.  Larger projects compete for centrally controlled NAF funds.  Funding for these larger projects is approved by the Air Force MWR Advisory Board, and authorization ranges from the Deputy Assistant Secretary of the Air Force (Installations), SAF/MII, to Congress.


2.  Army/Air Force Exchange Services (AAFES):  Examples of these are the Base Exchange (BX) and other sales outlets on the installation.  Funding for projects is approved by AAFES.  Authorization ranges from the MAJCOM (may be delegated to the installation) to Congress.


3.  Privately Owned Activities:  Funding is approved by the activity using the facility (e.g., credit unions or banks).  Most of these projects must be authorized at or above the HQ USAF/CE level.  Tenant and Associate Funding:  Tenant and associate units usually provide the funding for construction or alteration of facilities they use.  Although the funding programs are the same as in the host unit, the advocacy for the project and its defense through the approval and appropriation process is accomplished by the tenant’s Major Command.  It is important that the tenant and associate units be represented on the installation Facilities Board so that tenant projects can be integrated with the installation’s Architectural Compatibility Plan.

Other Funding Sources:

Other funding sources may be available depending on the situation at your installation.  Examples of other sources include the North Atlantic Treaty Organization (NATO), Host Nation Programs, Department of Defense Dependent Schools (DODDS), Defense Commissary Agency (DeCA), and Base Realignment and Closure (BRAC) Commission

Boards and Committees

Each installation has a number of boards, committees, and panels which, to varying degrees, can affect facility planning.  

Facilities Board

From a planning perspective, the most significant of these is the Facilities Board (FB).  The FB plays a significant role in the planning and programming of facilities on an installation.  You will be a key participant of this board and should become intimately familiar with its structure, responsibilities, and operating procedures. 

The FB is chaired by the Installation Commander and is composed of both voting and nonvoting members representing each major function and tenant unit on the installation.  It provides corporate review and recommendations regarding the use of real property facilities and civil engineering resources in support of the mission.

The following actions must be validated, prioritized, and approved by the FB:

· real property maintenance and repair projects above CE approval authority

· minor construction projects above CE approval authority

· the Military Construction Program (MILCON)

· the Military Family Housing (MFH) program for maintenance and repair 

· post-acquisition construction

· use of existing facilities

· the installation Comprehensive/Architectural Compatibility Plan
· facility sitings

· proposed acquisition or disposal of real property

· annual Real Property Inventory

· all proposed real property use changes

· annual review of airfield obstruction waivers

Base Operating System Resource Allocation Team

At the Major Command level, a Base Operating System Resource Allocation Team (BOSRAT) performs essentially the same functions as an installation-level FB.  It validates, prioritizes, and approves facility programs submitted by its subordinate installations.

Environmental Protection Committee

Another group that could have a significant impact on facility design and area development plans is the Environmental Protection Committee (EPC).  The EPC is charged with achieving and maintaining environmental quality on an installation and oversees installation compliance with local, state, and federal environmental guidelines.  It must review and approve environmental impact analyses on proposed actions and make recommendations to decision makers.

Assistance Team Program

A resource that can provide architectural compatibility assistance is Assistance Teams (ATs).  ATs are ad hoc groups that can be organized to address a variety of design and planning issues on installations.  For example, once a problem has been identified on an installation, the MAJCOM, in coordination with the Air Force Center for Environmental Excellence (AFCEE), may want to assemble an AT to visit the installation and make recommendations on how to solve the problem.  Team members typically consist of representatives from agencies across the Air Force, the Department of Defense (DOD), or others with expertise in the problem area.  

Other

Other functional agencies which may influence facility design, and with whom you should coordinate your plans, include operations, logistics, and communications.  Seek other installation and command level boards or committees that could impact planning on your installation.  Either volunteer to be member as a CE representative or be placed on the distribution list for meeting minutes.  It is important that you develop a feedback system that will provide regular updates on potential projects.
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Visual District Standards

Like the Chapter Title Style above, and the Chapter Subtitle you’re reading, Word’s preset Styles are just a few clicks away.
t
o save time in the future, print a copy of this document. Choose Print from the File menu, and press Enter to receive all 8 pages of examples and instructions. With the printed document in hand, position yourself in Normal View to see the Style names next to each paragraph. Scroll through 

Overview and Comprehensive Map

The “icon key” at left was produced using the Heading 8 Style for the words “icon key,” and the List Bullet 5 Style for the text below—which uses a Wingdings symbol for the bullet character. To change the bullet symbol, choose Bullets and Numbering from the Format menu. Click modify, and click the Bullet button. Choose a new symbol, and click OK twice to exit.
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The “icon key” at left was produced using the Heading 8 Style for the words “icon key,” and the List Bullet 5 Style for the text below—which uses a Wingdings symbol for the bullet character. To change the bullet symbol, choose Bullets and Numbering from the Format menu. Click modify, and click the Bullet button. Choose a new symbol, and click OK twice to exit.
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The “icon key” at left was produced using the Heading 8 Style for the words “icon key,” and the List Bullet 5 Style for the text below—which uses a Wingdings symbol for the bullet character. To change the bullet symbol, choose Bullets and Numbering from the Format menu. Click modify, and click the Bullet button. Choose a new symbol, and click OK twice to exit.
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The “icon key” at left was produced using the Heading 8 Style for the words “icon key,” and the List Bullet 5 Style for the text below—which uses a Wingdings symbol for the bullet character. To change the bullet symbol, choose Bullets and Numbering from the Format menu. Click modify, and click the Bullet button. Choose a new symbol, and click OK twice to exit.

Character

text

Assets

text

Liabilities

text

Future Development

In this manual, section breaks are the secret to success. Double-click the section break above to activate the Page Setup menu. Choose the Margins tab. As you can see, this section (page) has margins of 7.5 picas top and bottom, 14 picas left, and 5 picas right—with headers and footers of 4 picas. Special section margins make it possible for this manual to use framed Styles—such as the Icon 1 Style—which will move with the text.

Objectives

text

Desired Patterns

text

Design Standards

text

Themem

Scale

Form

Articulation

Materials

text

Color

text

Fenestration

test

Details

text

Appendices

Index

a

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 3, 3

Index 1, 1

Index 1, 1

b

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

c

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

d

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

e

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

g

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

h

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

k

Index 1, 1

L

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

m

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

n

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

r

Index 1, 1

Index 1, 1

s

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

t

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

w

Index 1, 1

Index 1, 1

Index 1, 1

Index 2, 2

Index 1, 1

Index 1, 1

Index 1, 1

Index 1, 1

3
ii

_948780071.xls
Sheet1

				Roofs										Exterior Wall										Wall Trim & Accents

		Visual District		Standing-seam Metal		Barrel-tile		Shingles		Low-sloped		Other		Precast Panels		Brick		Split-faced Block		Metal		Other		Precast Panels		Brick		Split-faced Block		Fluted Block		Metal		Other

		1		M												M

		2		M												M								O		O		O		O

		3		M												M								O		O		O		O

		4		M												M								O		O		O		O

		5		M												M								O		O		O		O

		6		M												M								O		O		O		O

		7		P						O				O		O								O		O		O		O

		8		P						O				O		O								O		O		O		O		O

		9		P		O				O						M												O		O

		10		M												M												O		O

		1

		1



&A

Page &P




